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Introduction
“The Preacher sought to find words of delight,
and uprightly he wrote words of truth” (Eccl 12:10 ESV).
Good, academic, theological writing makes a sound argument, and it does so winsomely. To
make an argument, an author must convey a certain amount of information. Merely conveying
information, however, is insufficient—the information must be shaped into an argument. To be
sound, this argument must account for all the relevant data and coherently relate them to each
other. Yet, even presenting a valid argument (“words of truth”), can look like a tangled mess of
words and phrases unless the valid argument is presented winsomely—that is, in “words of
delight.”
While this handout contains a few comments on crafting a sound argument, its main goal is to
provide guidance about presenting an argument winsomely. As such, these observations do
provide not a technical treatise but a practical guide toward forming academic prose that will
avoid impeding an audience’s enjoyment and comprehension of an argument (cf. Crider 2005,
73–78). After a brief introduction to academic writing as a rhetorical endeavor, attention is given
to basic issues of composition, and some suggestions are made about good, academic English
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style.
Finally, attention is given to the format and bibliography of the academic, theological paper. The
Society of Biblical Literature Handbook of Style already provides a great number of examples
and instructions for special cases that theological students may encounter. This Handbook
derives from and adapts much material in the Chicago Manual of Style (Alexander et al. 1999,
1), which Kate Turabian’s Manual for Writers condenses without adaptation (Turabian 2007, xi).
This more modest, condensing impulse of Turabian’s Manual renders this book a valuable
reference about Chicago style that is, perhaps, more accessible than the full Chicago Manual.
For students who use Turabian’s Manual, however, clear guidance for its application in specific
cases that students in Judeo-Christian Studies frequently face can sometimes be difficult to
obtain. Therefore, this last section seeks to provide this guidance and seeks to clarify the
Manual’s prescriptions for these difficult instances. Consequently, this final section essentially
attempts to do for students in Judeo-Christian Studies with Turabian’s Manual what Turabian
did for the Chicago Manual.
As with all academic endeavors, this handout itself is a work in progress. Those who find errors
or who have suggestions for improvement are encouraged to visit the webpage listed at the
beginning of this document and post their comments. A WordPress account is required to
comment, and one of these accounts can be obtained for free with or without a WordPress blog.
Please note that the webpage noted at the beginning of this document on the cover sheet
cannot f unction as a help forum. For assistance through this kind of medium, students are
encouraged to visit a dedicated, academic writing forum site like the Essay Forum
(http://www.essayforum.com/). Additionally, students should note that this handout will only be
revised as time allows, but input about what changes would be most beneficial would be a great
asset in the revision process.

Rhetoric in Academic Writing
Writing academically is writing rhetorically—writing to convince one’s audience (e.g., a course
professor, one’s academic peers) about truth (Crider 2005, 4, 119). Although rhetoric involves
certain formulas, it is primarily a mental faculty (Crider 2005, 5–7). Having truth as its goal, fully
formed rhetoric, “in its finest and fullest manifestation[,] is a form of love” (Crider 2005, 12). In
addition to discovering means for persuading one’s audience toward truth, the writer as rhetor
carefully attends to what arguments will function best in a given situation to lead the audience
and the rhetor to truth (Crider 2005, 7–9, 59).
Rhetoric begins with invention, some conception of an argument, and invention commonly has
five topics: definition, comparison, relationship, circumstance, and testimony (Crider 2005, 29).
Once the rhetor has identified a coherent thesis (the main assertion that the essay will make, or
the primary interpretation for which the essay will argue), the rhetor can use these topics to
chart a course toward demonstrating the thesis (Crider 2005, 30): What terms or concepts need
to be defined? What similarities exist in the material relevant for the argument? What has other
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research shown about this issue and other, similar issues? The additional, subsidiary arguments
that such questions demonstrate and the manner in which these arguments are drawn together
toward the thesis are best organized according to an “immanent design,” or an arrangement
suggested by the arguments themselves (Crider 2005, 43–47).
Even if written to people who have similar interests, an argument’s introduction should convince
its audience that the argument is worth reading (Crider 2005, 49). This introduction calls for a
certain degree of creativity to find some way of painting the argument’s substance in a way that
will please and intrigue the audience; if a rhetor succeeds in this task, the audience will be more
willing to spend the time and effort to ponder the argument proper (Crider 2005, 53). The
introduction should also briefly outline the essential contours of the argument that the rhetor
intends to prosecute; doing so aids the argument’s rhetoric by providing the audience a
concrete set of expectations, which the rhetor can attempt to meet (Crider 2005, 55–56). Along
the way to meeting these expectations, the rhetor should consider and account for possible
counter-arguments (Crider 2005, 59): What weaknesses in the argument do these potential
contraventions suggest? How can these weaknesses best be remedied? After prosecuting the
argument, the rhetor should briefly conclude (Crider 2005, 61–62). Conclusions frequently
summarize, but they may also suggest additional implications that the central argument has,
emotionally move the audience, or return to a theme or idea included in the introduction (Crider
2005, 62–63).
Throughout the introduction, argument, and conclusion, the rhetor must use an appropriate style
of language because an inappropriate style will hamper the audience’s reception of the
argument (Crider 2005, 73–74, 77–78, 84). Particularly apt for academic writing is a kind of
“middle style” that steers a course between the colloquialism of conversational language and
the elevation of highly stylized discourse (Crider 2005, 74–77). This middle style includes
conventions about word choice, sentence construction, figures of speech, and formatting (Crider
2005, 79–104), and some of these features are described later in this document. Together, a
rhetor’s use of these elements suggest certain things about that rhetor and give the audience a
certain picture of who the rhetor is—a picture that may aid or inhibit the rhetor’s persuasive task
(Crider 2005, 77–78, 84–87).
Once constructed, an academic essay needs a second look that does more than seek
opportunities to make editorial changes (Crider 2005, 109). The writing needs to be evaluated in
terms of how well it fulfills its objectives while also considering how sharp is the essay’s focus,
how clear its thesis, how developed its logic, and how complete its explanations. The piece
should then be edited accordingly (Crider 2005, 110). Such revision allows a rhetor to enhance
the craftsmanship that the argument exhibits and to increase the argument’s ability to move its
audience toward truth (Crider 2005, 118).

Specific Kinds of Writing
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Book Reviews
One effective plan for a book review is to dedicate about the first half of the review to: (1) briefly
introducing the work, (2) clearly identify book’s thesis, and (3) sketching the book’s argument for
this thesis. Then, you may dedicate roughly the second half of your review to: (1) clearly stating
your own thesis that somehow relates to the book you are reviewing, (2) sketching a coherent
argument for this thesis, and (3) concluding your review in a way that somehow reflects the
nature of book under consideration.

Interpretive Essays
Introduction
The introduction should seek to establish a connection with your audience and interest them in
reading your essay. You can often do these kinds of things by asking an insightful question,
briefly narrating a relevant illustration, or including a relevant quotation. The main point here is
to lead the audience into the essay and up to the thesis statement at the end of the introduction
in such a way that shows how or why the essay is significant for the argument it makes in itself
rather than simply as content to fulfill a particular assignment's requirements in a particular
course. When an introduction does frame the essay’s significance in this way, once the
audience has read the introduction, then they should be much more ready to follow the essay’s
argument as a whole and, if the argument is well-made, even to come to agree with the
position(s) that you take throughout your essay.

Thesis Statement and Body
The essay’s thesis is the main argument, position, or standpoint that you are taking about your
essay’s topic. Rhetorically, placing a thesis statement at the end of your introductory paragraph
or section identifies for your audience the position that they can expect you to demonstrate in
the rest of the essay. Simply by identifying this position, you prepare your audience to receive
the argument that you will present, and you make it that much easier for them to accept your
argument and come to the same position that you hold about your essay’s topic. Situating the
thesis statement at the end of your introduction allows your introduction the opportunity to frame
the thesis statement’s significance and describe the context of the problem or question to which
your thesis statement responds.
For an “interpretive essay,” this topic already has some boundaries—namely, the interpretation
of some source. Within Judeo-Christian Studies, this “source” is often to be taken from a
canonical biblical text. Because the essay’s nature is interpretive, the essay will somehow
address this text’s meaning. Therefore, if you have trouble developing a thesis statement for a
given biblical text, you can try giving yourself a bit of a running start by beginning a sentence
with “This text [argues, asserts, shows, teaches, or synonyms] that . . . .”
When you complete this sentence, whatever follows the “that” represent your interpretive
essay’s thesis, or its central assertion. When you write the thesis statement into the essay, you
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will particularly want to be sure that the thesis is specific enough for the essay you intend to
write. The more specific you can make your thesis statement, the more it will help clarify in your
audience’s minds the argument that you are wanting your essay to make. Consequently, as a
practical matter, your thesis statement should clearly (1) identify the particular biblical text that
your essay will discuss and (2) state the interpretation that your essay will argue for this text.
If you are working with a narrative text, your thesis statement should do more than restate the
text’s plot. For example, consider Aesop’s fable about the lion and the mouse. In this story, the
lion spares the life of a mouse that he could have eaten. Later, the lion becomes trapped and is
rescued by the same mouse whose life he spared. These things are the characters and events
within the story, but they are not the meaning o
 f the story. Rather, the meaning of the story is
something like “Be kind to everyone because you may end up needing someone else to be kind
to you.” As with this illustration from one of Aesop’s fables, if a biblical narrative is designed to
teach wisdom, then its meaning, or what the story teaches, may be something like a moral
principle. If the story is designed to report a point of salvation history, then the narrative may
have its primary meaning in describing a particular scene within this salvation-historical drama.
For instance, in Rom 4, Paul draws from Genesis’ narrative about Abraham not precisely a
moral point but a portrait of the identity of the people of Israel’s God.
When composing your thesis statement, try to structure it as “advanced organizer” for the
balance of your essay. Doing so will help your audience see how your essay’s argument
develops to demonstrate your thesis. For instance, a rough thesis statement for your essay
could go something like “[1] Paul prosecutes his argument in Romans 9–11 by highlighting
election as a divinely-established reality that is shaped by both corporate and individual
dynamics. [2] When the church attends properly to this interplay, Romans 9–11 provides her a
more robust resource for her theological and missiological formation.” In this example, the first
part of the essay would then demonstrate [1], and the second part would demonstrate [2].
Particularly in interpretive or exegetical essays, it can be tempting to structure the argument
according to some step-by-step hermeneutical method or verse-by-verse through the text. Yet,
the essay’s structure (i.e., the organization of its argument) will appear most coherent and make
the strongest argument to the audience if it matches the structure of the thesis statement.
Consequently, it may be advantageous to handle certain steps or texts “out of order” in the
essay in order to show the audience more clearly the interpretation that you are arguing for a
particular pericope.

Conclusion
Your conclusion is your opportunity to give one last push for your thesis—one last appeal for
your audience to adopt your position on your essay’s topic. With this goal in mind, wrapping a
conclusion back to the thesis statement is often an effective way of developing a conclusion.
Although you will not typically want to repeat your thesis or your earlier argument(s) needlessly
or verbatim in your conclusion, echoing or paraphrasing your thesis, perhaps in conjunction with
some of your major arguments can be a very effective concluding technique. Additional, helpful
suggestions on writing conclusions are available in the Smarthinking Writer’s Handbook.
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Composition and Style
The following composition and stylistic suggestions are intended to replicate the advice of the
latest edition of Turabian’s Manual s pecifically as it applies to writing in Judeo-Christian Studies:
1. Use appropriate punctuation. Some common oversights in punctuation are:
a. Omitting commas:
i. After an introductory word or phrase (e.g., In the garage, Jack fixed the
car.). For brief introductory words or phrases, a comma is not always
necessary (cf. Strunk Jr. and White 2000, 2), but the longer and more
complex that an introductory phrase (or clause) becomes, the more that
delimiting this phrase with a comma will help the reader follow the
sentence’s flow. To assess whether a comma would be beneficial in a
specific case, an author can often read the sentence aloud. If a pause
naturally falls in the reading after the introductory phrase, a comma may
be used. If no pause naturally falls after the introductory phrase, a comma
may be omitted.
ii. Around non-essential, sentence elements.
1. For example, the sentence “Jack, who works as a mechanic, fixed
his own car” would require commas enclosing the non-essential
clause “who works as a mechanic” because Jack’s name
sufficiently identifies him. On the other hand, the sentence “The
man who works as a mechanic fixed his own car” requires the
clause “who works as a mechanic.” In the first sentence, the
dependent clause describes Jack further; in the second sentence,
the reader does not know which man the writer means without the
dependent clause (Chapman 1996, 172). Determining whether a
given sentence element is essential or non-essential can
sometimes be a matter of judgment, but the more ambiguous a
sentence is without a given part of it, the more essential that part
is to the sentence.
2. Other non-essential, sentence elements may simply interrupt the
flow of a sentence by providing additional, parenthetical
information. For instance, in the sentence “Jack would argue,
therefore, that one should fix cars in a garage,” the word
“therefore” interrupts the normal flow of the clause in which it
stands (i.e., “Jack would argue . . . that”). Readers will find these
bracketing commas helpful in understanding a sentence’s flow,
especially when the interrupting information constitutes one or
more phrases or even its own clause.
iii. Around adverbial, participial phrases. Without commas, the sentence
“The mechanics waiting for the necessary parts to arrive complained
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about how slow the delivery man was” describes mechanics who were
“waiting.” The phrase “waiting for the necessary parts to arrive” would,
therefore, be adjectival. By contrast, the sentence “The mechanics,
waiting for the necessary parts to arrive, complained about how slow the
delivery man was” states that the mechanics complained in a way that
was connected with their “waiting.” Commas around adverbial, participial
phrases may, therefore, play a significant role in clarifying precisely what
these phrases modify.
iv. Before a conjunction that coordinates two independent clauses within the
same sentence (Strunk Jr. and White 2000, 5). Without a comma, “Jack
works as a mechanic and he fixes his own car” is a run-on sentence
because the coordinating conjunction “and” does not sufficiently join the
two clauses “John works as a mechanic” and “he fixes his own car.”
Adding a comma before the conjunction (e.g., “Jack works as a mechanic,
and he fixes his own car”) clearly coordinates the sentence’s two main
clauses.
v. Before the last item in a list (Turabian 2007, 23.4.2). Preferences may
differ in some contexts, but unless one is writing journalism, the
conjunction that denotes the final item in a list will generally have a
comma before it. Consequently, for biblical and theological studies, the
punctuation “At the store, Jack bought tires, sponges, and oil” would
normally be preferable to “At the store, Jack bought tires, sponges and
oil.”
vi. Between adjectives that modify the same noun and are not coordinated
by a comma. Thus, “Jack used the big, red wrench to fix the car” would be
appropriate.
1. In some cases, however, an adjective and the noun it modifies
may form a “stock phrase.” In these cases, the adjective-noun
combination should be treated as a single noun in relation to this
punctuation principle. Consequently, “Christian higher education”
would be preferable to “Christian, higher education” because
“higher education” forms a stock phrase that designates any
education after high school. Therefore, in such cases, unless an
author wishes to draw a special distinction in a given context, the
stock phrase is generally counted as a single noun when
punctuating the text.
2. Similarly, adjectives that denote quantity (e.g., “many,” “one,”
“three,” “several”) also do not generally take a comma between
them and another adjective that modfies a noun (e.g., “five black
tires”).
b. Placing punctuation before parenthetical references. For instance,
Scripture teaches that God loves the world, (John 3:16) but it also
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teaches that God hates sinners. (Ps 11:5)
would be incorrect, but
Scripture teaches that God loves the world (John 3:16), but it also
teaches that God hates sinners (Ps 11:5).
would be correct (Turabian 2007, 21.11.2).
c. Inappropriately punctuating multiple parts of a parenthetical reference. Inside
parenthetical references (as well as footnotes), use semicolons to separate
individual citations. For instance, “Scripture teaches that God loves the world
(John 3:16), but it also teaches that God hates sinners (Ps 11:5; cf. Prov
6:16–19).”
d. Misordering punctuation and quotation marks (e.g., Jack said, “I wish this car
would start”.). Although conventions differ in other English-speaking countries, for
standard, American English, commas and periods typically appear before a
closing quotation mark, and colons and semicolons always appear after a closing
quotation mark. Exclamation points (which should be rare in academic writing)
and question marks appear before a final quotation mark if they are part of the
original quotation; otherwise, they appear after the final quotation mark (Turabian
2007, 21.11.2).
e. Omitting italics when discussing a word or phrase as such. Thus, for clarity’s
sake, when discussing the word word or the phrase i n this phrase you would
typically use italics to set off from the main text the word or phrase under
discussion (Turabian 2007, 22.2.2).
f. Using hyphens (-) instead of en dashes (–) in number ranges. Sometimes an en
dash is called a hyphen, but a noticeable typographic distinction exists between
the two punctuation marks. When using an en dash to signal a range, do not
include a space on either side of the dash (so: 50–52 not 50 – 52; see Turabian
2007, 21.7.2n1, 23.2.4). Please see your computer software’s help sections for
assistance with adding hyphens and en dashes to your documents. Steps that
will work for some common software platforms, however, appear below:
i. For Windows users, an en dash may be inserted by turning on the Num
Lock, holding down the Alt key, typing 0150 on the keypad, and releasing
the Alt key.
ii. Microsoft Word (XP, 2003) users can construct a keystroke shortcut by
clicking the Insert menu > Symbol… > Special Characters > En Dash >
Shortcut Key. Hold down the desired shortcut key combination (e.g., Alt +
n), release the key combination, and click Assign.
iii. OpenOffice.org (3.1) users can construct a keystroke shortcut under
Microsoft Windows by clicking the Tools menu > Macros > Record Macro.
Hold down the Alt key, type 0150 on the keypad, and release the Alt key.
Click Stop Recording, name the macro appropriately (e.g., EnDash), and
click close. Click the Tools menu > Customize > Keyboard. Select the
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2.

3.

4.

5.

6.

desired key combination (e.g., Ctrl + N). Under Functions in the Category
box, click OpenOffice.org macros > user > Standard > Module1, and
choose the new macro (e.g., EnDash). Click the Modify button, and click
OK.
g. Using semicolons rather than commas to list page numbers. As with other series,
page a list of page numbers in a citation should be joined with commas, but no
conjunction should appear before the final page number listed (e.g., 2, 10–15, 32;
Turabian 2007, 21.2.2, 23.2.4).
h. Printing ellipses with inconsistent spacing. Some word processors automatically
change three successive periods into an ellipsis character (e.g., …), but this
character may not accurately space the ellipsis dots so that, in context (e.g.,
“Jack forgot … his screwdriver.”), a spacing difference can be noticeable. In such
a case, to achieve a uniform appearance, simply type three periods separated
from each other by one space (cf. Turabian 2007, 25.3.2). Ellipses are generally
omitted at the beginning or ending of a quotation (Turabian 2007, 25.3.2).
i. Using a mixture of "straight" and “smart” (or curled) quotes. Choose one style of
quotation marks and use it consistently.
j. Failing to nest quotation marks properly. When including within quotation marks
any material that itself contains quotation marks, the outermost quotation marks
should be double (“ ”), the next outermost quotation marks should be single (‘ ’),
and subsequent levels of quotation marks should alternate between the two
(Turabian 2007, 25.2.1, Special Punctuation; University of Chicago 2010, 13.28).
Use correct capitalization.
a. Titles of works in footnotes and bibliography items should be printed with
headline-style capitalization (see Turabian 2007, 22.3.1, Headline-style
Capitalization, for details).
b. Consult a standard dictionary for information on individual words. One common
mistake is capitalizing “city” when used with a city name (“city of Jerusalem” not
“City of Jerusalem”).
Use correlating conjunctions together. When using the correlating conjunctions
(either/or, neither/nor, both/and, not only/but also), use both parts of the correlating pair,
and place them appropriately so that each one correlates the same kind of grammatical
structure(s) as the other does (cf. §).
Use quotation marks to indicate direct quotations. Paraphrased material, by contrast,
should not be enclosed in quotation marks, but its source(s) must still be cited.
Additionally, each opening quotation mark must have a corresponding closing quotation
mark, and vice versa.
Avoid sentence fragments. Each sentence must have a subject and a verb in an
independent clause. Sentences with transitive verbs (i.e., verbs require an object to
make sense) must also have an object (Chapman 1996, 14).
Avoid dangling prepositions. Sometimes, a dangling preposition can simply be deleted.
For example, “Jack does not know where his wrench is at” should be changed to “Jack
does not know where his wrench is.” Other times, a sentence needs to be restructured to
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give a dangling preposition an appropriate object. For instance, “Jack wondered who he
could borrow a wrench from” should be revised to “Jack wondered from whom he could
borrow a wrench.” See a standard dictionary if uncertainty exists about whether a word is
a preposition or not.
7. Avoid split infinitives. A split infinitive occurs whenever the infinitive verb form (e.g., “do”)
is not immediately preceded by the preposition “to” as in the phrase “to do.” To remedy
the split infinitive, the interrupting word or phrase can often be relocated easily to one of
three locations: (1) before the word “to,” (2) after the infinitive verb form, or (3) the end of
the clause. When relocating a modifying word or phrase to the end of the clause,
however, be especially careful not to create a misplaced modifier.
8. Use “were” instead of “was” in the “if” clause of an unreal condition. For example, “If Jack
was a woman, he would not be a man” is incorrect, but “If Jack were a woman, he would
not be a man” is correct.
9. Use the correct case of a noun or pronoun with a gerund or present participle. Although
the gerund and present participle have the same form (e.g., “taking”), a gerund would
take the possessive case. For example, “Jack’s taking the test before March 1 allowed
him to graduate.” That is, the fact that Jack took the test before March 1 allowed him to
graduate. By contrast, a present participle would take the objective case, as in the
sentence, “Jill saw Jack taking his test before March 1 in order to graduate.” In other
words, Jill saw Jack while he was taking his test that would allow him to graduate (Strunk
Jr. and White 2000, 12–13).
10. Be clear. Clarity and simplicity often go together in writing, but simplicity does not entail
compositional roughness. Rather, clarity and simplicity entail removing language that
attempts to impress the reader by its obscurity and including language that
communicates meaning as efficiently as possible.
a. Often, authors may use pronouns whose antecedents are ambiguous (e.g.,
“When Jack went to walk the dog, he ran away”). In these cases, use a noun in
place of the pronoun, or add the appropriate qualification (e.g., “When Jack went
to walk the dog, the dog ran away”). Particularly, long strings of pronouns can
hamper clarity, albeit sometimes humorously, as the number of possible
antecedents increases (e.g., “Jack and Jill caught some fish, and they ate them”).
When using a pronoun, students should always check whether the pronoun’s
antecedent is ambiguous. If a pronoun is ambiguous in this way, the pronoun can
be replaced with a noun, or the sentence can be recast.
b. Shifts in number between an antecedent and a following pronoun should be
avoided. For example, “When anyone tells Jack how to fix a car, they should
avoid telling Jack what he already knows” would be incorrect, but “When anyone
tells Jack how to fix a car, that person should avoid telling Jack what he already
knows” would be correct.
c. Sometimes, indirect discourse may be reported without being introduced by “that”
[e.g., “Jack said (that) he needed to go to the auto-parts store”]. Other times,
including “that” to introduce the indirect discourse can greatly increase a
sentence’s clarity.
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d. A sentence’s parts must exhibit unity. To do so, they should: (1) be closely
related, (2) be clear, and (3) express a single, overarching thought (Chapman
1996, 91). A paragraph’s sentences must also exhibit unity by developing only
the idea of the paragraph’s topic sentence (Chapman 1996, 196). Sentences
developing other ideas belong in other paragraphs.
e. Similar to unity is coherence. To be coherent, a paragraph’s components must be
arranged in a logical order (e.g., chronology, space, importance) and create a
sense of continuity by employing appropriate devices (e.g., pronoun reference,
repetition, and transitional expressions) (Chapman 1996, 198; see also Turabian
2007, 9.2).
f. Avoid using short-hand constructions like “and/or.” For example, “Jack wondered
whether to fix the car and/or mow the lawn.” This sentence’s clarity can be
increased by reworking the sentence into the following form: “Jack wondered
whether to fix the car, mow the law, or do both” (Strunk 40).
11. Be concise. When one word is at least as clear as two, use one. Some common ways to
increase conciseness are to translate constructions like: (1) “the basis of this argument,”
into constructions like “this argument’s basis,” (2) “during the time which” > “when,” (3)
“in which” > “where,” (3) “the reason . . . is because” > “because,” (4) “he is a man who
does” > “he does” (Strunk Jr. and White 2000, 23–24, 48).
12. Choose the best word. Words are the basis of communication. Without them, there can
be no sentences, and with the wrong words, sentences will not mean to their readers
what their authors intend them to mean.
13. Use words and phrases appropriately.
a. Although usage conventions differ in other English-speaking communities,
standard, American English calls for “a” before a voiced “h” (e.g., “a healthy
desire”) and “an” before an unvoiced “h” followed by a vowel sound (e.g., “an
honorable mention”).
b. The words “and” and “but” should not appear at the beginning of a sentence, but
they may appear at the beginning of a clause within a sentence.
c. One useful, though frequently neglected, stylistic convention employs the word
“however” at the beginning of a clause to express indefinite means or extent
(e.g., “However Jack decides to repair my car, I will simply be glad to have it
fixed.”). As a synonym for “but,” “however” may be advantageously relocated to
some logical break in the clause it coordinates with the preceding material (e.g.,
“Jack wanted to have the car repaired yesterday; as the day progressed,
however, he realized he had too much other work to do.”) (Strunk Jr. and White
2000, 48–49).
d. When using “one” as a pronoun, avoid subsequently using the pronouns “he,”
“she,” or some combination of the two. Gendered pronouns are becoming
increasingly out-of-fashion in American English for indefinitely gendered
instances of the third person singular. The use of “one” as a pronoun, in many
cases, provides a viable gender-neutral substitute for the gender-specific third
person pronouns “he” and “she.” When using “one” as a pronoun, however, an
11

author should avoid following it with gender-specific pronouns. Moreover, ad hoc
pronoun combinations (e.g., “he or she,” “he/she,” and “s/he”) are cumbersome
and should be avoided (Strunk Jr. and White 2000, 54–55, 60–61).
e. American usage prefers the preposition “toward” (e.g., “toward the sea”) while
British usage prefers “towards” (Chapman 1996, 153).The word “as” may be
used as a synonym for “like,” but “as” can sound odd when used with something
other than a full clause. In general, therefore, the safer route is to use “like” to
compare nouns and pronouns and “as” to compare phrases and clauses (cf.
Strunk Jr. and White 2000, 51–52).
f. Choosing between “that” (as a relative pronoun) and “which” can often be
difficult. “That” may refer to persons or things; “which” refers to things (Chapman
1996, 153). “That” seems to flow more smoothly in a wider variety of cases,
whereas “which,” in some instances, can sound stilted and awkward (cf. Strunk
Jr. and White 2000, 59).
g. When writing ordinal numbers, be consistent in omitting or including the “-ly”
ending (e.g., “first,” “firstly”). Omitting this ending is generally preferred (Strunk Jr.
and White 2000, 57).
h. Avoid writing “as to” (e.g., “Jack spoke as to the nature of the argument”), which
may be pretentious. Instead, be simpler and more concise with a word like
“about” or “concerning” (e.g., “Jack spoke about the nature of the argument”).
i. Avoid using “etc.,” which is inexact. In academic writing, if something is important
enough to merit an “etc.,” that thing is important enough to name explicitly
(Strunk Jr. and White 2000, 45).
j. Use “Bible” to refer to the scriptures of the Judeo-Christian tradition and “biblical”
to describe a particular text(s) as falling within this class of scriptures.
k. Use “Gospel” to refer to an early Christian narrative about Jesus’ life (e.g.,
Matthew–John) and “gospel” to refer to the Christian message about Jesus.
l. Generally prefer the “literary” present tense when discussing the message of a
text or an action of an author through his or her text. Thus, “In his book, Jack
says” would typically be preferable to “In his book, Jack said” if the message of
the book rather than its situation in a historical sequence is the primary focus.
14. Avoid widows and orphans. Generally, any paragraph should have at least one full line
on the page where it begins and at least one full line on the page where it ends
(University of Chicago 2010, 2.113). Many word processing programs can perform this
task automatically. For specific instructions about this feature, see the help files for the
individual programs.
15. Strive for balance and parallelism. When coordinating two or more phrases or clauses,
an author should place conjunctions properly so that each conjunction coordinates the
same grammatical structure as the others. For instance, the phrases “in both his
theology and in his political views” lack balance because the first conjunction (“both”)
coordinates only the object of the first preposition (“in”), but the second conjunction
(“and”) coordinates the whole second, prepositional phrase (“in his political views”). To
correct this imbalance, the author has two options. First, the author can relocate an
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imbalanced element to a more appropriate position (“both in his theology and in his
political views”). Second, the author can eliminate an unbalancing element (“in both his
theology and his political views”). The author may decide which solution to adopt based
on which construction will fit the context best.
16. Avoid awkward wordings. Unclear phrases, ambiguous phrases, and unintentionally
idiomatic phrases particularly increase a sentence’s awkwardness. Sometimes ambiguity
or lack of clarity can be reduced or eliminated by using additional punctuation to guide
the reader about how to divide the sentence. A careful reader, especially one who is not
a technical scholar in the field in which a given paper is written, can often identify
awkward wordings, which the author might not have noticed and which require revision.
17. Avoid claiming more than the argument or cited evidence demonstrates. Global claims
with words like “all,” “every,” “each,” “always,” or “never” and claims about a majority
(with a word like “most”) are particularly suspicious in this regard. Whatever claims and
conclusions an author makes must be supported by: (1) his own argument, (2) the works
he cites, or (3) a combination of both.
18. Avoid using the first person. This rule includes avoiding the use of the first-person,
singular and plural pronouns. Using these pronouns is not grammatically wrong. But, in
academic writing, it is a stylistically less effective option. Academic writing requires that
authors stress the logic and evidence that support the arguments being made. By
contrast, first-person references tend to draw attention away from logic (logos) and
evidence and toward the author's own competence with the subject matter (ethos).
Recognized experts in particular subjects can sometimes argue effectively from their
authorial ethos, but even here, such arguments would generally be still more effective if
they focused on carefully outlining an appeal from logos that the expert’s special
knowledge of the field identifies as particularly meriting consideration (cf. Crider 2005,
16–18, 33–35).
19. Avoid using the second person. Directly addressing the reader is generally inappropriate
for academic writing.
20. Avoid misplaced modifiers. A misplaced modifier is any modifying word, phrase, or
clause, which does not modify what the author intended it to modify from its current
position in the sentence. Additionally, modifiers may sometimes be ambiguously placed
so that their connections to the rest of the sentence are unclear. For example, “Jack told
his wife how he had fixed the car after dinner” means something very different from
“After dinner, Jack told his wife how he had fixed the car.”
21. Avoid short paragraphs of fewer than three sentences. A one- or two-sentence
paragraph should typically be expanded or reworked and combined with the preceding
or following paragraph. Very short paragraphs can result in a choppy text and suggest
that you have given insufficiently careful thought to that paragraph’s topic.
22. Avoid run-on sentences. Run-on sentences often occur when long sentences have
insufficient subordination or coordination of their clauses. Rework a run-on sentence’s
subordination or coordination, or divide a run-on sentence into one or more, shorter
sentences. To aid a sentence that has insufficient coordination, consider adding a
comma with a coordinating conjunction where independent clauses join each other.
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Additionally, a semi-colon can join two independent clauses by itself and does not
generally take a coordinating conjunction when used in this capacity.
23. Avoid choppy sentences. While sentences can be too long, they can also be too short,
especially when several short sentences occur in sequence. Choppy sentences can be
combined as long as run-ons do not result.
24. Avoid contractions.
25. Avoid “prop” phrases like “it is interesting that.” Instead of saying that something is
interesting, interest the reader in it by demonstrating its significance (Strunk Jr. and
White 2000, 50).
26. Avoid numerous and lengthy quotations. In general, directly quote only texts that are
essential to proving an argument; merely cite others in the appropriate format (Crider
2005, 36). Doing so well can help strengthen your authorial ethos.
a. When quoting any material, the quotation should develop logically from what
precedes it, and contribute toward your argument’s further demonstration. Simply
quoting a particular author or scholar as articulating a particular position does not
necessarily make the quotation contribute effectively to the argument into which it
is inserted. Especially when quoting secondary sources, you must establish (1)
whether the author(s) you have quoted is actually correct in what they assert and
(2) what this correct assertion contributes to your own argument.
b. In an interpretive essay on a biblical text, the text being handled should generally
not be quoted in full. Instead, the audience for such an essay may generally be
presumed to be familiar with the text or able to refer to it with sufficient ease. In
this case, your space is best spent arguing your interpretation of your text rather
than quoting it at length.
27. Format and Bibliography
a. Use at least one-inch margins on all sides of the page, perhaps leaving a larger
left margin of 1.5 inches for a thesis or dissertation so that it can be properly
bound (Turabian 2007, A.1.1). Although Turabian gives some flexibility with
margin size, using its specified minimum margin width of 1 inch on all sides of the
page is fairly standard as a local guideline.
b. Unless text is centered (e.g., headings), use left rather than full justification
(Turabian 2007, 20.4.1). For example, in a typical paragraph, the first line should
be indented, the rest of the lines should be flush with the left margin, and the right
margin should be “ragged.”
c. Use a standard font face and size consistently throughout your document;
random changes in font face and size should be scrupulously avoided. Typically,
Times New Roman is the standard font face of choice for academic essays,
although another similar font face might be usable. A font size of 12 points is
preferable for a document’s main text, but a 10-point font size may be used as an
alternative. The font size used for footnotes should not be larger than that used in
the main text and should typically not be smaller than 10 points. So, if the
document’s main text uses a 12-point font, footnotes may use either 10- or
12-point font. On the other hand, if the document’s main text uses a 10-point font,
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d.

e.

f.

g.

h.
i.

j.

footnotes should also use a 10-point font (Turabian 2007, A.1.2).
Place page numbers appropriately. Place no page number on the title page,
number front matter with Roman numerals beginning with “ii” on the page after
the title page, and number document’s main text with Arabic numerals beginning
with “1” on the first page of the paper’s body. Normally, for term papers, page
numbers will appear in the upper, right-hand corner on all pages except the title
page (Turabian 2007, A.2). Conventionally, neither front nor back matter counts
toward satisfying an assignment’s length requirement. The technical steps
required to create this page numbering can take some practice, but reviewing
your word processor’s relevant help articles should clarify the steps required
(e.g., LibreOffice 3 [pgs. 39–42]; Microsoft Word 2003, 2007, 2010;
OpenOffice.org 3).
Consistently use appropriate heading formatting. See the Turabian manual for its
suggested section heading formats, and do not print a heading at the bottom of a
page (Turabian 2007, A.2.2).
Do not include a space between a punctuation mark and a footnote number. A
footnote number in a paper’s main text should appear immediately after a
terminal punctuation mark with no intervening spacing.
Use only one blank line between paragraphs. The body of a paper should be
double-spaced throughout (except for block quotations). No extra line should be
added between paragraphs (Turabian 2007, A.1.3, fig. A.9).
Use only one space between a terminal punctuation mark and the beginning of
the next sentence (Turabian 2007, 21.1, 21.5–21.6, A.1.3).
Ensure that you consistently use the proper citation format. Turabian includes
two separate citation styles: notes-bibliography (Turabian 2007, 16–17) and
parenthetical citation-reference list (Turabian 2007, 18–19). Placement of the
in-text citations in a footnote or a parenthetical reference easily distinguishes the
two styles in this respect. Nevertheless, the two citation styles also have two
different bibliography formats that may more easily be confused. For writers in
Judeo-Christian Studies, the notes-bibliography format is standard, but local
guidelines may prescribe differently in particular cases.
Format footnotes appropriately.
i. Indent the first line of a footnote (including the note number) by the same
amount as you indent the first line of a regular paragraph. Tabs or other
firm formatting measures, rather than spaces, should be used to achieve
the necessary indentation (Turabian 2007, 16.1.7, A.1.3).
ii. Do not italicize footnote numbers.
iii. Use single spacing inside each footnote, but put a blank line between
each footnote and any immediately following footnote on the same page
(Turabian 2007, 16.3.4, figs. A.9–A.10, A.12).
iv. Omit a blank line between the footnote rule and the first footnote on a
page, but do not indent the footnote rule as you do with the first line of a
footnote. The footnote rule should always start at the left margin
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(Turabian 2007, figs. A.9–A.10, A.12).
v. Note the place of publication properly (see Turabian 2007, 17.1.6). For
works with multiple places of publication and possibly multiple publishers
listed, cite the work according to the first-listed place of publication and
the publisher’s name appropriate for that location. When a place of
publication is well-known, use only the city name. When a place of
publication is not well-known or might easily be confused with another
place with a similar name:
1. If the place is within the United States, use the format: [City],
[Standard, two-letter postal abbreviation].
2. If the place is outside the United States, use the format: [City],
[Appropriate local governmental entity, such as state or province].
For still greater specificity if necessary, the string “, [Country]” may
be added to the end of this list after the appropriate local
governmental entity.
vi. To conserve space, authors may omit an initial “The” and abbreviations
like “Co.”, “Inc.”, and “Publishing Co.” in publishers’ names (Turabian
2007, 17.1.6). Turabian does not mandate this practice, but writers in
Judeo-Christian studies typically observe it.
vii. When citing an edited volume with the editor’s name before the title, place
a comma after the abbreviation “ed.”
viii. Format authors’ names appropriately.
1. When citing or referring to an author with an academic or
professional title (e.g., “Dr.,” “M. D.,” “Rev.”), writers in
Judeo-Christian Studies will generally omit this title and use only
the author’s name. When referring to an author in the text of a
paper, the author’s first and last name (e.g., “John Piper”) or last
name and initial(s) (e.g., “N. T. Wright”) are generally only used for
the first reference to that author.
2. When citing or referring an author whose name includes two or
more initials, use the initials as the author does, and place a
non-breaking space after each initial (e.g., N. T. Wright, F. F.
Bruce, J. B. Lightfoot; Turabian 2007, 24.2.1).
3. When mentioning an author whose name contains an Umlaut, you
should represent the Umlaut as part of that name’s particular
spelling. In many cases, a word processor or character map can
be used to insert a symbol or special character that will properly
display the Umlaut over the correct vowel. Representing an
Umlaut as such is the preferred method. If you are not able to
insert a single character that combines a particular vowel with an
Umlaut, however, you should represent the Umlaut by adding an
“e” after the vowel over which the Umlaut would normally appear.
Thus, for example, “Andreas Köstenberger” or “Andreas
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Koestenberger” would be appropriate, but not “Andreas
Kostenberger.” Similarly, one might wright “W. G. Kümmel” or “W.
G. Kuemmel” but should not write “W. G. Kummel.”
4. Subsequent references to the same author in the paper’s main
text should typically refer to that author only by the author’s last
name (e.g., “Piper,” “Wright”; Turabian 2007, 24.2.1).
5. When referring to authors in bibliographies, Turabian style
requires that the family (or last) name be put first and that a
comma and the given (or first) name or initials should follow. Thus,
in a bibliography, one would have “Piper, John.” The period after
the author’s last-listed given name or initial should not be doubled.
Thus, “Wright, N. T.” would be appropriate but not “Wright, N. T..”
(e.g., Turabian 2007, 17.1.1).
ix. For the first use of a given source, employ the individual citation format
most applicable to that source. Examples of important categories of
sources for writers in Judeo-Christian Studies are given here according to
the discipline’s standard notes-bibliography citation style preference.
Please see your local guidelines to confirm whether this standard
preference applies in your particular situation.
1. Standard books with one author and no editors, editions, or
translators (Turabian 2007, 17.1.1)
1. Craig L. Blomberg, Interpreting the Parables (Downers
Grove, IL: InterVarsity Press, 1990), 17.
3. Blomberg, Interpreting the Parables, 17.
Blomberg, Craig L. Interpreting the Parables. Downers Grove, IL:
InterVarsity Press, 1990.
2. Books with multiple authors or editors (Turabian 2007, 17.1.1)
1. Walter C. Kaiser and Moisés Silva, An Introduction to
Biblical Hermeneutics: The Search for Meaning (Grand Rapids:
Zondervan Publishing House, 1994), 75.

75.

3. Kaiser and Silva, Introduction to Biblical Hermeneutics,

Kaiser, Walter C., and Moisés Silva. An Introduction to Biblical
Hermeneutics: The Search for Meaning. Grand Rapids:
Zondervan Publishing House, 1994.
3. Books listed under an editor(s) instead of an author(s) (Turabian
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2007, 17.1.1)
1. Moisés Silva, ed., Foundations of Contemporary
Interpretation (Grand Rapids: Zondervan Publishing House, 1996),
377.
3. Silva, Foundations of Contemporary Interpretation, 377.
Silva, Moisés, ed. Foundations of Contemporary Interpretation.
Grand Rapids: Zondervan Publishing House, 1996.
4. Books listed under an editor(s) instead of an author(s) and found
in an electronic database (Turabian 2007, 17.1.10)
1. Philip R. Davies, ed., Scribes and Schools: The
Canonization of the Hebrew Scriptures, Library of Ancient Israel
(Louisville, KY: Westminster John Knox Press, 1998), 36,
http://search.ebscohost.com.ezproxy.liberty.edu:2048/login.aspx?
direct=true&db=nlebk&AN=41120&site=ehost-live&scope=site&eb
v=1 (accessed July 21, 2012).
3. Davies, Scribes and Schools, 36.
Davies, Philip R., ed. Scribes and Schools: The Canonization of
the Hebrew Scriptures. Library of Ancient Israel. Louisville,
KY: Westminster John Knox Press, 1998.
http://search.ebscohost.com.ezproxy.liberty.edu:2048/login
.aspx?direct=true&db=nlebk&AN=41120&site=ehost-live&s
cope=site&ebv=1 (accessed July 21, 2012).
5. Books with an author(s) and an editor(s) (Turabian 2007, 17.1.1)
1. Kate L. Turabian, A Manual for Writers of Research
Papers, Theses, and Dissertations: Chicago Style for Students
and Researchers, ed. Wayne C. Booth, Gregory G. Colomb, and
Joseph M. Williams, 7th ed. (Chicago: University of Chicago
Press, 2007), 59.
3. Turabian, Manual for Writers, 59.
Turabian, Kate L. A Manual for Writers of Research Papers,
Theses, and Dissertations: Chicago Style for Students and
Researchers. Edited by Wayne C. Booth, Gregory G.
Colomb, and Joseph M. Williams. 7th ed. Chicago:

18

University of Chicago Press, 2007.
6. Books with an author(s) and a translator(s) (Turabian 2007,
17.1.1)
1. Thomas Aquinas, A Summa of the Summa, ed. Peter
Kreeft, trans. Fathers of the English Dominican Province (San
Francisco: Ignatius, 1990), 254.
3. Aquinas, Summa, 254.
Aquinas, Thomas. A Summa of the Summa. Edited by Peter
Kreeft. Translated by Fathers of the English Dominican
Province. San Francisco: Ignatius, 1990.
7. Specific editions of works (Turabian 2007, 17.1.3)
1. Kate L. Turabian, A Manual for Writers of Research
Papers, Theses, and Dissertations: Chicago Style for Students
and Researchers, ed. Wayne C. Booth, Gregory G. Colomb, and
Joseph M. Williams, 7th ed. (Chicago: University of Chicago
Press, 2007), 59.
3. Turabian, Manual for Writers, 59.
Turabian, Kate L. A Manual for Writers of Research Papers,
Theses, and Dissertations: Chicago Style for Students and
Researchers. Edited by Wayne C. Booth, Gregory G.
Colomb, and Joseph M. Williams. 7th ed. Chicago:
University of Chicago Press, 2007.
8. Titled sections of edited collections (Turabian 2007, 17.1.8)
1. J. Maxwell Miller, “Reading the Bible Historically: The
Historian’s Approach,” in To Each Its Own Meaning: An
Introduction to Biblical Criticisms and Their Application, ed. Steven
L. McKenzie and Stephen R. Haynes, rev. ed. (Louisville, KY:
Westminster John Knox Press, 1999), 17–34.
3. Miller, “Reading the Bible Historically,” 17–34.
Miller, J. Maxwell. “Reading the Bible Historically: The Historian’s
Approach.” In To Each Its Own Meaning: An Introduction to
Biblical Criticisms and Their Application, edited by Steven
L. McKenzie and Stephen R. Haynes, 17–34. Rev. ed.
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Louisville, KY: Westminster John Knox Press, 1999.
9. Signed dictionary articles (Turabian 17.1.8)
1. James H. Charlesworth, “Apocrypha: Old Testament
Apocrypha,” in vol. 1 of The Anchor Bible Dictionary, ed. David
Noel Freedman et al. (New York: Doubleday Publishing, 1992),
292–94.
3. Charlesworth, “Old Testament Apocrypha,” 292–94.
Charlesworth, James H. “Apocrypha: Old Testament Apocrypha.”
In vol. 1 of The Anchor Bible Dictionary, edited by David
Noel Freedman, Astrid B. Becj, Gary A, Herion, David F.
Graf, John David Pliens, Phillip C. Schmitz, and Leslie
Barkley, 292–94. New York: Doubleday Publishing, 1992.
10. Unsigned dictionary articles (Turabian 2007, 17.5.3)
1. Greek-English Lexicon of the New Testament and Other
Early Christian Literature, 3rd ed., s.v. “καί.”
3. Greek-English Lexicon of the New Testament, s.v. “καί.”
Bauer, Walter, Frederick W. Danker, William Arndt, and F. Wilbur
Gingrich, eds. A Greek-English Lexicon of the New
Testament and Other Early Christian Literature. Translated
by Frederick W. Danker. 3rd ed. Chicago: University of
Chicago Press, 2000.
11. Journal articles (Turabian 2007, 17.2.4)
1. Gabriel Barzalai, “Incidental Biblical Exegesis in the
Qumran Scrolls and Its Importance for the Study of the Second
Temple Period,” Dead Sea Discoveries 14, no. 1 (2007): 15.
3. Barzali, “Incidental Biblical Exegesis in the Qumran
Scrolls,” 15.
Barzalai, Gabriel. “Incidental Biblical Exegesis in the Qumran
Scrolls and Its Importance for the Study of the Second
Temple Period.” Dead Sea Discoveries 14, no. 1 (2007):
1–24.
12. Journal articles obtained from an electronic database (Turabian
2007, 17.2.7)
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1. George J. Brooke, “Qumran Pesher: Towards the
Redefinition of a Genre,” Revue de Qumran 10, no. 4 (1981): 488,
http://search.ebscohost.com/login.aspx?direct=true&db=rfh&AN=A
TLA0000794502&site=ehost-live (accessed September 22, 2009).
3. Brooke, “Qumran Pesher,” 503.
Brooke, George J. “Qumran Pesher: Towards the Redefinition of a
Genre.” Revue de Qumran 10, no. 4 (1981): 483–503.
http://search.ebscohost.com/login.aspx?direct=true&db=rfh
&AN=ATLA0000794502&site=ehost-live (accessed
September 22, 2009).
13. Journal articles from special issues (Turabian 2007, 17.2.6)
1. Michael W. Casey, “An Era of Controversy and Division:
The Origins of the Broadway Church of Christ, Paducah,
Kentucky,” in “Perspectives on Division, Christian Church
(Disciples of Christ) and Churches of Christ,” ed. Thomas H.
Olbricht, special issue, Restoration Quarterly 27, no. 1 (1984): 14.
3. Casey, “An Era of Controversy and Division,” 18.
Casey, Michael W. “An Era of Controversy and Division: The
Origins of the Broadway Church of Christ, Paducah,
Kentucky.” In “Perspectives on Division, Christian Church
(Disciples of Christ) and Churches of Christ,” ed. Thomas
H. Olbricht. Special issue, Restoration Quarterly 27, no. 1.
(1984): 2–22.
14. CD- or DVD-ROM resources (Turabian 2007, 17.5.8)
1. G. K. Beale and D. A. Carson, eds., Commentary on the
New Testament Use of the Old Testament, CD-ROM, Libronix
Digital Library System, version 3.0g (Bellingham, WA: Logos Bible
Software, 2007), 165.
3. Beale and Carson, Commentary on the New Testament
Use of the Old Testament, 165.
Beale, G. K., and D. A. Carson, eds. Commentary on the New
Testament Use of the Old Testament. CD-ROM, Libronix
Digital Library System, version 3.0g. Bellingham, WA:
Logos Bible Software, 2007.
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15. Multi-volume works (Turabian 2007, 17.1.4)
1. John Lightfoot, A Commentary on the New Testament
from the Talmud and Hebraica, Matthew–1 Corinthians (Oxford:
Oxford University Press, 1859; repr., Peabody, MA: Hendrickson,
1989), 2:100.
3. Lightfoot, Commentary on the New Testament from the
Talmud and Hebraica, 3:65.
Lightfoot, John. A Commentary on the New Testament from the
Talmud and Hebraica, Matthew–1 Corinthians. 4 vols.
Oxford: Oxford University Press, 1859; repr., Peabody,
Mass.: Hendrickson, 1989.
16. A titled volume in a multi-volume work (Turabian 2007, 17.1.4)
1. William Baird, From Deism to Tübingen, vol. 1 of History
of New Testament Research (Minneapolis: Augsburg Fortress,
1992), 176.
3. Baird, From Deism to Tübingen, 176.
Baird, William. From Deism to Tübingen. Vol. 1 of History of New
Testament Research. Minneapolis: Augsburg Fortress,
1992.
17. A titled volume in a series (Turabian 2013, 17.1.5)
1. James D. G. Dunn, Romans, Word Biblical
Commentary, ed. Bruce M. Metzger et al., vol. 38 (Dallas: Word,
1988), 463.
3. Dunn, Romans, 325.
Dunn, James D. G. Romans. Word Biblical Commentary. Edited
by Bruce M. Metzger, David A. Hubbard, Glenn W. Barker,
Ralf P. Martin, and Lynn Allan Losie, vol. 38. Dallas: Word,
1988.
18. A thesis or dissertation (Turabian 2007, 17.6.1)
1. J. David Stark, “The Hermeneutical Roles of the
Teacher of Righteousness and Jesus of Nazareth in the Qumran
Sectarian Manuscripts and the Epistle to the Romans” (PhD diss.,
Southeastern Baptist Theological Seminary, 2011), 125.
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3. Stark, “The Hermeneutical Roles of the Teacher of
Righteousness and Jesus of Nazareth,” 125.
Stark, J. David. “The Hermeneutical Roles of the Teacher of
Righteousness and Jesus of Nazareth in the Qumran
Sectarian Manuscripts and the Epistle to the Romans.”
PhD diss., Southeastern Baptist Theological Seminary,
2011.
19. Reprints (Turabian 2007, 17.1.3, 19.1.4)
1. John Lightfoot, A Commentary on the New Testament
from the Talmud and Hebraica, Matthew–1 Corinthians (Oxford:
Oxford University Press, 1859; repr., Peabody, MA: Hendrickson
Publishers, 1989), 2:100.
3. Lightfoot, Commentary on the New Testament from the
Talmud and Hebraica, 3:65.
Lightfoot, John. A Commentary on the New Testament from the
Talmud and Hebraica, Matthew–1 Corinthians. 4 vols.
Oxford: Oxford University Press, 1859; repr., Peabody,
MA: Hendrickson Publishers, 1989.
20. Lectures obtained from an electronic database (Turabian 2007,
17.2.7, 17.6.2)
1. J. R. Davila, “The War Rule” (lecture, University of St.
Andrews, St. Andrews, Scotland, February 22, 2005),
http://www.st-andrews.ac.uk/~www_sd/warrule.html (accessed
February 21, 2008).
3. Davila, “The War Rule.”
Davila, J. R. “The War Rule.” Lecture, University of St. Andrews,
St. Andrews, Scotland, February 22, 2005.
http://www.st-andrews.ac.uk/~www_sd/warrule.html
(accessed February 21, 2008).
21. Electronic books (Chicago Manual of Style 2010, 14.166)
a. If print-equivalent pagination is available:
1. Eric Metaxas, Bonhoeffer: Pastor, Martyr, Prophet, Spy.
(Nashville: Thomas Nelson, 2010), Kindle edition, 358.
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3. Metaxas, Bonhoeffer, 358.
Metaxas, Eric. Bonhoeffer: Pastor, Martyr, Prophet, Spy.
Nashville: Thomas Nelson, 2010. Kindle edition.
b. If print-equivalent pagination is not available:
1. Eric Metaxas, Bonhoeffer: Pastor, Martyr, Prophet, Spy.
(Nashville: Thomas Nelson, 2010), Kindle edition, chap. 23.
3. Metaxas, Bonhoeffer, chap. 23.
Metaxas, Eric. Bonhoeffer: Pastor, Martyr, Prophet, Spy.
Nashville: Thomas Nelson, 2010. Kindle edition.
x. Use abbreviated footnotes when appropriate. For a subsequent reference
to a given source, use the short note format (Turabian 2007, 16.4.1)
unless the immediately preceding citation comes from the same source.
In this case, use the citation format “Ibid., [page number].” If the source
and page number(s) in one citation are both identical to the source and
page number(s) in the immediately preceding citation, simply use the
abbreviation “Ibid.” in the second footnote (Turabian 2007, 16.4.2).
k. Format the title page properly (Turabian 2007, figure A.1).
l. Format the bibliography properly (Turabian 2007, 16.1.7, A.1.3, A.2.3,
Bibliography or Reference List; figs. A.15, A.16).
i. In the notes-bibliography citation style, bibliography entries should not be
numbered but should be arranged in alphabetical order according to the
first term(s) present in a particular bibliography item’s text (e.g., the last
name of the work’s first-listed author or editor). For essays, the whole
bibliography is typically presented as a single list without additional
categorization into subcategories of different, related items.
ii. Each bibliography item should be single spaced with a blank line between
it and the next bibliography item listed on the same page. Each
bibliography item should be indented the same amount as a normal
paragraph, but the indentation should be in the hanging rather than
first-line format. In this way, only the first line of a given bibliography entry
will be touching the left margin. All other lines will be indented by the
same amount as a normal paragraph is indented. Rather than spaces,
tabs or other firm formatting measures, rather than spaces, should be
employed to achieve the necessary indentation.
iii. If your bibliography lists two works consecutively that are alphabetized
under the same author or editor’s name, after the first entry for this author
or editor’s name, you should replace the name with three consecutive em
dashes (one: —; three: ———; for an example, see Turabian 2007, fig.
A.16).
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1. For Windows users, an em dash may be inserted by turning on the
Num Lock, holding down the Alt key, typing 0151 on the keypad,
and releasing the Alt key.
2. Microsoft Word (XP, 2003) users can construct a keystroke
shortcut by clicking the Insert menu > Symbol… > Special
Characters > Em Dash > Shortcut Key. Hold down the desired
shortcut key combination (e.g., Alt + m), release the key
combination, and click Assign.
3. OpenOffice.org (3.1) users can construct a keystroke shortcut
under Microsoft Windows by clicking the Tools menu > Macros >
Record Macro. Hold down the Alt key, type 0151 on the keypad,
and release the Alt key. Click Stop Recording, name the macro
appropriately (e.g., EmDash), and click close. Click the Tools
menu > Customize > Keyboard. Select the desired key
combination (e.g., Ctrl + M). Under Functions in the Category box,
click OpenOffice.org macros > user > Standard > Module1, and
choose the new macro (e.g., EmDash). Click the Modify button,
and click OK.
Format quotations of five lines or more into block quotations. Block quotations
should omit quotation marks around them but should be presented (a)
single-spaced and (b) indented on all lines as far as the first line of a normal
paragraph (Turabian 2007, 25.2.2).
When using Arabic numerals to designate page ranges, use complete numbers
or abbreviate them consistently. A given range’s minimum and maximum number
may be written out in full in Arabic numerals at all times. Or, the range’s
maximum may be abbreviated in certain ways and at certain times (Turabian
2007, 23.2.4). Please see your local guideline’s preferences for how these range
maximums are to be displayed.
Use correct era abbreviations in the correct places. An author should choose
either the BC/AD or the BCE/CE abbreviation set and follow that choice
consistently. No periods should be used with either abbreviation set (i.e., “BCE”
not “B.C.E.”). For the BCE/CE pair, the abbreviation always follows the year (e.g.,
70 CE). For the BC/AD set, BC follows the year (e.g., 150 BC), but AD precedes
the year (e.g., AD 70; Turabian 2007, 23.3.2).
Type biblical languages properly, and generally cite the lexical form of a given
word unless citing that word in context with a larger phrase in the biblical text.
i. For Greek, change a grave accent to an acute when the word with the
grave is not followed immediately by another Greek word. Thus, write δέ
rather than δὲ, but write ο δὲ κύριος. Additionally, be sure to type a final
sigma (ς) when a sigma ends a word. For Greek miniscules, always
include the appropriate diacritics (i.e., accents, breathing marks).
ii. For Hebrew and Aramaic, omit vowel points and Massoretic cantilation
marks unless they are relevant to the argument being made.
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iii. The line spacing for biblical language fonts may be larger than the line
spacing for the Times New Roman font. Thus, a line with 12-point, Times
New Roman font English text and 12-point, SBL Greek font text may
appear to have more space between itself and the lines around it than it
would if the line contained only Times New Roman text. To compensate
for this typographical quirk, decrease the font size of the biblical language
text enough so that the line spacing returns approximately to what it
would be with only Times New Roman text, but do not decrease the
biblical language font size so much that the Greek text becomes difficult
to read on a printed page.
q. Abbreviate biblical citations consistently.
i. Never write out a verse reference (e.g., John, chapter one, verse one).
Instead, always use the abbreviated citation form with Arabic numerals
(e.g., John 1:1).
ii. Choose one set of book name abbreviations that the Turabian manual
provides, and employ that set consistently when citing a book with a
chapter and verse number (see Turabian 24.6.3). Note, however, that
book names that begin sentences should always be spelled fully (e.g., “In
Phlm 1:1, Paul and Timothy address the letter to its recipient. First
Thessalonians 1:1 also includes Silvanus in the letter’s list of senders.”)
Additionally, when citing a book and chapter without a verse number or
range, spell out the name of the book (Turabian 2007, 24.6).
iii. Whenever spelling out a book name in full, however, use the concise form
of the book name. Consequently, instead of something like “the Book of
the Prophet Isaiah 1,” prefer simply “Isaiah 1,” and in place of “the
Revelation of Saint John the Divine 5,” write simply “Revelation 5.”
iv. When using an English Bible translation, cite the translation abbreviation
(see Turabian 24.6.4) with the text quoted. Alternatively, if only or mainly
one translation is used, a footnote may be placed at the translation’s first
use explaining that, unless otherwise noted, all English Bible citations are
taken from this primary translation. Bible translations, however, are not
typically included in bibliographies (Turabian 17.5.2).
r. Italicize non-English words in Roman alphabets or transliterations.

Common Editorial Marks
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1

Some other, editorial marks that may appear are:
●
●
●
●
●
●
1

~ = reverse the order of the marked elements
(, ), or O = a suggestion has been made on a similar issue elsewhere
AW = this document, Advice for Writers in Judeo-Christian Studies
cit = add a citation
col = colloquial
cs = comma splice

For this table, see Chapman 1996, inside back cover.
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●
●
●
●
●
●
●
●
●
●
●

i = italicize
inform = informal
IS = Identifying Sources for a Scholarly Bibliography
LG(s) = local guideline(s)
mw = missing word
ni = do not italicize
secrel = the identified portion or section’s relevance to the main argument bears further
clarification
si = split infinitive
SW = see Strunk and White
T = see Turabian’s Manual
wc = questionable word choice

A Brief Bibliography of Writing Resources
Alexander, Patrick H., John F. Kutsko, James D. Ernest, Shirley Decker-Lucke, and David L.
Petersen, eds. 1999. The SBL Handbook of Style for Ancient Near Eastern, Biblical, and
Early Christian Studies. Peabody, Mass.: Hendrickson.
Baskervill, William Malone, and James Witt Sewell. 1895. An English Grammar for the Use of
High School, Academy, and College Classes. New York: American.
http://books.google.com/books?id=KCJKAAAAIAAJ.
Bilsky, Manuel, McRea Hazlett, Robert E. Streeter, and Richard M. Weaver. 1953. “Looking for
an Argument.” College English 14, no. 4: 210–16.
Blount, Alma, and Clark Sutherland Northup. 1914. “An English Grammar for Use in High and
Normal Schools and in Colleges.” Vol. 4. Progressive Studies in English. New York:
Henry Holt. http://books.google.com/books?id=4OAAAAAAYAAJ.
Browne, M. Neil. 2007. Asking the Right Questions: A Guide to Critical Thinking. 8th ed. Upper
Saddle River, N.J.: Prentice Hall.
Carpenter, George Rice. 1902. Principles of English Grammar for the Use of Schools.
Text-Books on English. New York/London: MacMillan.
http://books.google.com/books?id=YgFMAAAAMAAJ.
Chapman, James A. 1996. A Handbook of Grammar and Composition. 3rd ed. Pensacola, Fla.:
A Beka Book.
Corbett, Edward P. J., and Rosa A. Eberly. 2000. The Elements of Reasoning. 2nd ed. The
Elements of Composition Series. Needham Heights, Mass.: Pearson.
Crider, Scott F. 2005. Office of Assertion: An Art of Rhetoric for the Academic Essay.
28

Wilmington, Del.: Intercollegiate Studies Institute.
Donald, Robert B. 1996. Word Power. In Writing Clear Essays, 31ff. 3rd ed. Upper Saddle
River, N.J.: Prentice Hall.
Huddleston, Rodney, and Geoffrey K. Pullum. 2005. A Student’s Introduction to English
Grammar. Cambridge: Cambridge University.
Huddleston, Rodney D. 1988. English Grammar. Cambridge: Cambridge University.
http://books.google.com/books?id=R4gl7uo7QTMC.
Huddleston, Rodney D., and Geoffrey K. Pullum. 2002. The Cambridge Grammar of the English
Language. Cambridge: Cambridge University.
Koopman, Harry Lyman. 1896. The Mastery of Books: Hints on Reading and the Use of
Libraries. New York: American. http://books.google.com/books?id=EjI-AAAAIAAJ.
Leedy, Paul D., and Jeanne E. Ormrod. 2010. Practical Research: Planning and Design. 9th ed.
MyEducationLab. Upper Saddle River, N.J.: Prentice Hall.
Merriam-Webster. 1994. Concise Dictionary of English Usage. 1st ed. Springfield, Mass.:
Merriam-Webster. http://books.google.com/books?id=2yJusP0vrdgC.
Strunk Jr., William, and E. B. White. 2000. The Elements of Style. 4th ed. New York: Longman.
Turabian, Kate L. 2007. A Manual for Writers of Research Papers, Theses, and Dissertations:
Chicago Style for Students and Researchers. Ed. Wayne C. Booth, Gregory G. Colomb,
and Joseph M. Williams. 7th ed. Chicago: University of Chicago.
Weston, Anthony. 2000. A Rulebook for Arguments. 3rd ed. Indianapolis, Ind.: Hackett.
Williams, Joseph M. 1995. Style: Toward Clarity and Grace. Chicago: University of Chicago.

29

